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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 
MCP19117 Flyback Stand-Alone Evaluation Board. Items discussed in this chapter 
include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Web Site

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to install the MCP19117 Flyback Stand-Alone Evaluation 
Board. It also describes how to operate the Evaluation Board. The manual layout is as 
follows:

• Chapter 1. “Product Overview” – Important information about the MCP19117 
Flyback Stand-Alone Evaluation Board.

• Chapter 2. “Installation and Operation” – Includes instructions on how to get 
started with the MCP19117 Flyback Stand-Alone Evaluation Board.

• Chapter 3. “Graphical User Interface (GUI) Features” – Includes instructions 
on the MCP19117 Flyback Standalone GUI.

• Appendix A. “Schematic and Layouts” – Shows the schematic and layout 
diagrams for the MCP19117 Flyback Stand-Alone Evaluation Board.

• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 
MCP19117 Flyback Stand-Alone Evaluation Board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}



Preface

 2016 Microchip Technology Inc. DS50002472A-page 9

RECOMMENDED READING

This user's guide describes how to use MCP19117 Flyback Stand-Alone Evaluation 
Board. Other useful documents are listed below. The following Microchip documents 
are available and recommended as supplemental reference resources.

• MCP19116/7 Data Sheet – “Digitally Enhanced Power Analog Synchronous 
Low-Side PWM Controller” (DS20005479)

• MPLAB® X IDE User Guide – “PICkit™ 3 In-Circuit Debugger/Programmer 
User’s Guide For MPLAB® X IDE” (DS52116)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 
http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (March 2016)

Initial Release of this Document.

http://www.microchip.com/support
http://www.microchip.com/support
www.microchip.com
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Chapter 1.  Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MCP19117 Flyback Stand-Alone Evaluation 
Board and covers the following topics:

• MCP19117 Short Overview

• What is the MCP19117 Flyback Stand-Alone Evaluation Board?

• MCP19117 Flyback Stand-Alone Evaluation Board Kit Contents

1.2 MCP19117 SHORT OVERVIEW

The MCP19117 is a highly integrated, mixed-signal, analog pulse width-modulation 
(PWM) current mode controller with an integrated microcontroller core, and offers syn-
chronous or asynchronous operation. Since the MCP19117 device uses traditional 
analog control circuitry to regulate the output current or voltage, the integration of the 
PIC® microcontroller mid-range core is used to provide complete customization of the 
device’s operating parameters, protection levels, programmable offset, dead-times, 
slope compensation and fault handling procedures.

The MCP19117 has two internal low drop-out regulators (LDOs). A 5V LDO (VDD) pro-
vides internal power to all the digital circuitry and can supply limited external power at 
the VDD pin. A 4V LDO (AVDD) provides power to the internal analog circuitry and sup-
plies the reference voltage to the ADC. This device features synchronous low-side inte-
grated drivers and 8k Words non-volatile memory, all in a space-saving 28-pin 5x5 mm 
QFN package. 

To support traditional MOSFETs, pin 20 (VDR) is used to provide input power to the two 
low-side synchronous gate drivers. The evaluation board is populated with the 
Microchip TC1240AECHTR voltage doubler. Resistor population provides the option of 
powering VDR with 10V through the TC1240AECHTR voltage doubler (R19, R21 
populated; R22 not populated) or 5V (R22 populated; R19, R21 not populated) 
gate-drive capability.

User firmware, including device configuration, is loaded using Microchip’s MPLAB® X 
Integrated Development Environment (IDE). A graphical user’s interface (GUI) is used 
to communicate with and edit operating parameters of the MCP19117. The GUI com-
municates via I2C using the PICkit™ Serial Analyzer. 

The GUI offers the user the ability to adjust the programmable features available in the 
MCP19117. Note that the interface cannot stop the user from uploading incorrect set-
tings to the device. Incorrect settings may have unintended consequences, including, 
but not limited to, unstable operation, damaging the load, and even damaging of the 
MCP19117 device. It is the user's responsibility to understand the system effects of the 
parameters they enter.
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1.3 WHAT IS THE MCP19117 FLYBACK STAND-ALONE EVALUATION BOARD?

The MCP19117 Flyback Stand-Alone Evaluation Board is intended to 
demonstrate how the MCP19117 device operates in a synchronous flyback 
topology. It is configured to regulate load current and is also well-suited to drive 
LED loads. Nearly all operational and control system parameters are 
programmable by utilizing the integrated PIC Microcontroller core. 

The MCP19117 Flyback Stand-Alone Evaluation Board is delivered 
preprogrammed with firmware designed to operate with the GUI interface. 
MPLAB X IDE software can be used to download user-defined firmware, thus 
tailoring it to their specific application.The evaluation board contains headers 
for In-Circuit Serial Programming™ (ICSP) as well as I2C communication. 

Several test points have been designed into the printed circuit board for easy 
access and development purposes. The MCP19117 Flyback Stand-Alone 
Evaluation Board is also intended to demonstrate an optimized printed circuit 
board (PCB) layout that minimizes parasitics while increasing efficiency and 
power density. Proper PCB layout is critical to achieve optimum MCP19117 
operation as well as power train efficiency and noise minimization. The 
MPLAB X IDE, MCP19117 Flyback Standalone GUI and MCP19117 Flyback 
Stand-Alone firmware are available for download from Microchip’s web site. 
See Chapter 3. “Graphical User Interface (GUI) Features” for details.

1.4 MCP19117 FLYBACK STAND-ALONE EVALUATION BOARD KIT CONTENTS

The MCP19117 Flyback Stand-Alone Evaluation Board includes the following 
items:

• MCP19117 Flyback Stand-Alone Evaluation Board (ADM00663)

• Important Information Sheet
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Chapter 2.  Installation and Operation

2.1 ABOUT THE MCP19117 FLYBACK STAND-ALONE EVALUATION BOARD

The MCP19117 is a digitally-enhanced, power analog, synchronous low-side PWM 
controller. The GUI was developed to assist users in easily configuring the MCP19117 
and evaluating it in their target application.

The MCP19117 Flyback Stand-Alone Evaluation Board is designed to operate from a 
single supply (nominal 8V to 14V, 24V maximum). The primary side MOSFET has a 
maximum VDS rating of 100V. Users should be cautious that this 100V rating is not 
exceeded when determining input and output conditions for their application. The 
coupled inductor has a 2:1 ratio. The secondary MOSFET has a 200V maximum VDS 
rating.

The default configuration provides the gate drive supply (VDR) with 10V. Adequate 
ceramic and bulk capacitors are supplied on the input to reduce the root mean square 
(RMS) ripple current and lessen input voltage deviation caused by load transients. 
Ceramic capacitors are also provided on the output to reduce voltage ripple and 
provide energy to the output while the primary side is being re-energized.

The MCP19117 Flyback Stand-Alone Evaluation Board is fully assembled, pro-
grammed and tested to evaluate and demonstrate the MCP19117 operating perfor-
mance. Users will need to download and install the MCP19117 Flyback Standalone 
GUI from the Microchip website and become familiar with its operation before powering 
the MCP19117 Flyback Stand-Alone Evaluation Board.

2.2 SYSTEM AND CONFIGURATION REQUIREMENTS

To power-up and run the MCP19117 Flyback Stand-Alone Evaluation Board, the 
following is required:

• MCP19117 Flyback Standalone GUI 
• MCP19117 Flyback Stand-Alone Evaluation Board
• PICkit Serial Analyzer

For USB connectivity, the minimal physical requirement for the PC is a standard USB 
2.0 port. If the board connects to the PC through a USB hub, use a self-powered hub.

The MCP19117 Flyback Stand-Alone Evaluation Board comes with preprogrammed 
firmware installed to operate with the GUI. To reprogram the device, the following tools 
are required:

• MPLAB X IDE (version 3.05 or later)

• MPLAB® XC8 C Compiler (v1.35 or later)

• MCP19117 Flyback Standalone Firmware

• MCP19117 Flyback Stand-Alone Evaluation Board

• PICkit™ 3 In-Circuit Debugger/Programmer

The MCP19117 Flyback Standalone GUI requires a Microsoft Windows® XP/7/8 
operating system and a minimum screen resolution of 1024 x 768. 

Note: The factory-loaded firmware requires the use of the provided GUI to 
function. Without the GUI, the evaluation board does not operate. 
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2.3 CONNECTING POWER INPUT AND OUTPUT

Use the VIN and GND Test Points as shown below. Nominal VIN is +8V to +14V with 
the Positive terminal (Red) connected to VIN and the Negative terminal (Black) 
connected to GND.

FIGURE 2-1: Applying Power to the Board.

VOUT

GND

GND

VIN

CAUTION

Primary side MOSFET is Rated to 100V. The transformer turns ratio is 1:2. 

Do NOT exceed the 100V MOSFET Rating. Primary MOSFET (OFF) VDS = 0.5 x VOUT + VIN.
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2.4 INSTALLING THE MCP19117 FLYBACK STANDALONE GUI

The MCP19117 comes programmed with generic firmware that is compatible with the 
standalone GUI. It is up to the user to modify or create new firmware dedicated to their 
stand-alone application if different functionality is required. 

Perform the following steps to install the MCP19117 Flyback Standalone GUI:

1. Download the MCP19117 Flyback Standalone GUI software package from the 
Microchip web site. 

2. Extract the content of the archive files on the computer.

3. Double-click the setup.exe file to start software installation. Press the Install 
button in the Application Install window (Figure 2-2). After the installation 
completes, the application window is displayed (as shown in Figure 3-2 of 
Chapter 3. “Graphical User Interface (GUI) Features”).

FIGURE 2-2: MCP19117 Flyback Standalone GUI Installation Window.

Note: If the default firmware is modified, the GUI may no longer be compatible 
with the MCP19117 Flyback Stand-Alone Evaluation Board. 
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2.5 REPROGRAMMING THE MCP19117 FLYBACK STAND-ALONE EVALUATION 
BOARD

Perform the following steps to install necessary software and begin reprogramming the 
MCP19117 device:

1. If MPLAB X IDE is already installed, go to Step 2. If not, download MPLAB X IDE 
from: www.microchip.com/mplabx, and follow the installation instructions.

2. If the MPLAB XC8 C Compiler, or a compatible equivalent, is already installed in 
MPLAB X IDE, go to Step 3. If not, you can download a free version of the 
MPLAB XC8 C Compiler from: www.microchip.com/mplabxc. The user guide, 
installation instructions, and download links are available on the web page.

3. Download the MCP19117 - Flyback Stand-Alone Firmware 
(ADM00663_02_10403_U1-R2_Firmware.zip) from 
www.microchip.com/mcp19117 under "Documentation".

4. Unzip the MCP19117 - Flyback Stand-Alone Firmware archive. Place the 
MCP19117 project folder in the desired folder location. 

5. Power-up the MCP19117 Flyback Stand-Alone Evaluation Board.

6. Connect the PICkit 3 In-Circuit Debugger to the MCP19117 Flyback Stand-Alone 
Evaluation Board via the 6-pin connector J3, as seen in Figure 2-3. For more 
information about PICkit 3 In-Circuit Debugger refer to the PICkit™ 3 In-Circuit 
Debugger/Programmer User’s Guide For MPLAB® X IDE (DS52116).

FIGURE 2-3: PICkit 3 In-Circuit Debugger/Programmer Connected to the 
MCP19117 Flyback Stand-Alone Evaluation Board.

Note: When installed, MPLAB X IDE automatically creates a project folder. In 
Windows, this folder is typically located under 
drive\Users\user_name\MPLABXProjects.

www.microchip.com/mplabx
www.microchip.com/mplabx
www.microchip.com/mplabxc
www.microchip.com/mplabxc
www.microchip.com/mplabxc
www.microchip.com/mcp19117
www.microchip.com/mcp19117
www.microchip.com/mcp19117
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7. Open MPLAB X IDE to load the MCP19117 Flyback Stand-Alone firmware. From 
the File menu select Open Project (Figure 2-4).

FIGURE 2-4: Opening Project in MPLAB X IDE.

8. Browse for the location of the extracted firmware. Select the 
MCP19117_Stand_Alone from the list, then check the Open as Main Project 
option. Click the Open Project button to complete loading the file.

FIGURE 2-5: Loading Firmware into MPLAB X IDE.
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9. When the project is open, click the Make and Program Device Main Project button on the tool bar 
to program the device. Wait until the program process is complete (see Figure 2-6).

FIGURE 2-6: Selecting and Executing the Make and Program Device Main Project in MPLAB X 
IDE.
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Chapter 3.  Graphical User Interface (GUI) Features

3.1 ABOUT THE MCP19117 FLYBACK STANDALONE GUI

This chapter describes the steps that are required to launch the MCP19117 Flyback 
Standalone GUI.

3.1.1 Prerequisites

Prior to starting the GUI, perform these actions:

1. Apply an input voltage in the normal operating range (8V to 14V) at the VIN and 
Ground test points.

2. Connect the PICkit Serial Analyzer to the PC through USB port and then connect 
the analyzer to the Control Board via the 6-pin serial connector J5 (Figure 3-1).

FIGURE 3-1: PICkit Serial Analyzer Connection to the Board.
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3.1.2 Launching the GUI

To start the GUI, select Start > All Programs > Microchip Technology 
Inc. > MCP19117 FLYBACK_STANDALONE_GUI. 

The interface detects the MCP19117 device automatically and is ready for use (see 
Figure 3-2).

FIGURE 3-2: MCP19117 Flyback Standalone GUI - Initial Screen.
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        Online Adjust
             Register

Parameters
System 

Update
Register
Advanced
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3.2 MCP19117 FLYBACK STANDALONE GUI DESCRIPTION

As depicted in Figure 3-2, the MCP19117 Flyback Standalone GUI is divided into five 
areas: 

• System Parameters Area 

• Advanced Register Update Area

• Register Online Adjust Area

• Control Buttons Area

• Operating Status Box Area

3.2.1 System Parameters Area

The following sections are available in the System Parameters Area

• Drivers Enable/Disable Section

• Operating Mode Section

• Parameters Section

• Protection Section

• Switches Enable/Disable Section

• Test Pin Section

3.2.1.1 DRIVERS ENABLE/DISABLE SECTION

The “Drivers Enable/Disable” section contains an “ON” and an “OFF” check box. If the 
“OFF” check box is selected (default), the system turns off the Primary and Secondary 
Drivers and all the sections in the MCP19117 Flyback Standalone GUI become read 
only. In order for the sections to become editable, select the “ON” check box. 

3.2.1.2 OPERATING MODE SECTION

The “Operating Mode” section controls how the Flyback converter operates. Options 
are:

• Quasi-resonant: the controller will run Quasi-resonant mode and the switching 
frequency will vary depending on the operation conditions.

• Fixed Frequency: the switching frequency parameters are adjustable. By default, 
the check box is selected.

FIGURE 3-3: Operating Mode Options.

This section also contains a selection named Synchronous Operation. When the ON 
check box in the Drivers Enable/Disable section is selected, the Synchronous 
Operation check box is automatically selected – setting the MCP19117 Flyback 
Stand-Alone Evaluation Board to function in Synchronous mode.

If the Synchronous Operation check box is cleared, the evaluation board is set to 
function in Asynchronous Operation mode, which disables the secondary driver 
(SDRV).
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3.2.1.3 PARAMETERS SECTION

This section controls the Switching Frequency, Maximum Duty Cycle, Output Current 
and Current Sense Resistor parameters, as shown in Figure 3-4  

FIGURE 3-4: Parameters Options

The switching frequency is user programmable in Fixed Frequency mode over the 
range of 60 kHz to 1 MHz. Switching Frequency can be adjusted in 10 kHz intervals. 
The maximum duty cycle is programmable from 0 to 100%.
 

The Output Current can be adjusted within a range of 0 to 500 mA. The Current Sense 
Resistor (R6) value on the MCP19117 Flyback Stand-Alone Evaluation Board is 
200 m. Both of these values are used to calculate the set point value written to the 
VREFCON register. Do NOT raise the resistor value in the GUI without changing the 
resistor on the evaluation board to match. Failure to do so could result in damage to 
the evaluation board.

CAUTION

Increasing switching frequency results in increased switching losses in the MOSFETs. 
It is the user's responsibility to ensure that the MOSFETs are operated within their safe 
operating range.

Note: Attempting to write a value larger than 0xFF to VREFCON is prohibited by 
the GUI.
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3.2.1.4 PROTECTION SECTION

The “Protection” section (see Figure 3-5) allows the user to set levels for the three 
adjustable protection features: 

• Enable Input OVLO: specified range of 9V to 24V. The default setting is 18V. This 
parameter is configurable per its specified range.

• Enable Input UVLO: specified  range is 4V to 20V. The default setting is 8V. This 
parameter is configurable per its specified range.

• Enable Output OVLO: configurable range between 0V and 60V. The default 
setting is 40V. 

FIGURE 3-5: Protection Options.

In order for the user to be able to set different values, the corresponding check boxes 
of the features must be selected. Otherwise, the protections are not applied.

The LED (marked with D2) on the evaluation board is used to indicate various fault 
conditions. The firmware will flash this LED to indicate each of the following fault 
conditions:

• VIN UVLO FAULT: Short Flash Routine

• VIN OVLO FAULT: Long Flash Routine

• OUTPUT OV FAULT: Short/Long Flash Routine

3.2.1.5 SWITCHES ENABLE/DISABLE SECTION

There are two general purpose MOSFET low-side series switches located on 
MCP19117 Flyback Stand-Alone Evaluation Board (LSW1 and LSW2). The check 
boxes named “Switch 1” and “Switch 2” in the Switches Enable/Disable section of the 
GUI allow the user to turn these switches ON (selected) and OFF (cleared).

WARNING 

Use caution when changing from these default settings to ensure that damage will not 
occur. The VINUVLO, VINOVLO and Output OV controls adjust the VINUVLO, VINOVLO 
and OVREFCON registers, respectively.
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3.2.1.6 TEST PIN SECTION

The “Test Pin” section of the GUI has a drop-down menu that allows users to select and 
connect test signals to GPIO GPA0. These signals are accessible at the test point 
labeled TEST. The Test Pin can be configured to output several analog or digital 
parameters. See Figure 3-6 for the list of signals.

FIGURE 3-6: Test Pin Options.
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3.2.2 Advanced Register Update Area

This section of GUI gives the user more options to configure and operate the 
MCP19117 Flyback Stand-Alone Evaluation Board (see Figure 3-7).

FIGURE 3-7: Advanced Register Update Options.

Note that the Enable Edit check box must be selected in order for the section to become 
editable.

The parameters have drop-down lists with predetermined values can be selected.

.The adjustable parameters are the following:

• LEB: selects a time period (in nS) for the Leading Edge Blanking
• PDRV Deadtime: sets the delay time (in nS) for the primary driver

• SDRV Deadtime: sets the delay time (in nS) for the secondary driver

• Input Current Offset:: sets a value (in mV) in for the input current offset
• Slope Compensation: sets a value for the slope compensation

In addition, this section allows users to update up to four Special Function Registers 
(SFR) at the same time. For more information on Special Function Registers, refer to 
the MCP19116/7 Data Sheet – “Digitally Enhanced Power Analog Synchronous 
Low-Side PWM Controller” (DS20005479).

Leading
Edge
Blanking

Primary Driver 
Deadtime

Input Current 
Offset

Slope
Compensation 

Secondary
Driver Deadtime

Special
Function
Registers
Update Section 
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3.2.3 Register Online Adjust Area

The “Register Online Adjust” section of the GUI allows the user to have direct control 
of register values at any time when operating the MCP19117. The device data sheet 
contains information on register address locations and content. Reads and writes are 
done in hexadecimal format. Users must select the proper bank, which is especially 
important when executing a write. It is good practice to always execute an address read 
before a write, to check for expected results. This may help prevent an unintended write 
to an improper address or bank. Please note that the Update button will not update this 
section.

FIGURE 3-8: Register Online Adjust Options.

3.2.4 Control Buttons Area

From left to right (see Figure 3-9), the following four buttons are available:

• Initialize PICKit Serial button (selectable self-test option)

• Check for Evaluation Board button (selectable self-test option)

• Update button 

• Turn Off Drivers button 

FIGURE 3-9: Control Buttons.

In this section the user can perform the following actions:

• Click the Initialize PICkit Serial button for the system to check the communica-
tion between your computer and PICkit Serial Analyzer. 

• Click the Check for Evaluation Board to manually ask the system to detect the 
evaluation board.

• Click the Update button to apply the configuration settings made in “Operating 
Mode”, “Parameters”, “Protection”, “Switches Enable/Disable”, and “Advanced 
Register Update” areas. Clicking Update also turns on the output drivers. Note 
that it does not update information in the Register Online Adjust area.

• The Turn Off Drivers button is a master stop that shuts off the output drivers. 
Clicking this button disables both primary and secondary drivers. 

The system communicates whether the user action was successful or not in the Oper-
ating Status Box (see Figure 3-10).
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3.2.5 Operating Status Box Area

This text-box provides messages and operating status to the user. By default, the text 
box is blank. It is populated when actions are performed in other sections of the GUI  
(see Figure 3-10). The information is system-generated and read-only.

FIGURE 3-10: Operating Status Box.

The following messages are examples of text that may appear in this area: 

• MCP19117 Evaluation Board Not Detected

• PICkit Serial correctly configured for I2C

• MCP19117 Evaluation Board Update Successful 
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NOTES:
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Appendix A. Schematic and Layouts

A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP19117 
Flyback Stand-Alone Evaluation Board:

• Board – Schematic

• Board – Top Layer

• Board – Top Copper

• Board – Mid Layer 1

• Board – Mid Layer 2

• Board – Bottom Copper

• Board – Bottom Layer
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A.3 BOARD – TOP LAYER
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A.4 BOARD – TOP COPPER
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A.5 BOARD – MID LAYER 1
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A.6 BOARD – MID LAYER 2
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A.7 BOARD – BOTTOM COPPER



MCP19117 Flyback Stand-Alone Evaluation Board User’s Guide

DS50002472A-page 38  2016 Microchip Technology Inc.

A.8 BOARD – BOTTOM LAYER
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Appendix B. Bill of Materials (BOM)

TABLE 2-1: BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

4 C1, C2, 
C9, C10

DO NOT POPULATE

1 C3 CAP CER 1 µF 100V 10% X7R SMD 1206 Taiyo Yuden Co., 
Ltd.

HMK316B7105KL-T

2 C4, C5 CAP CER 10 µF 50V 20% X7S SMD 1210 TDK Corporation C3225X7S1H106M

2 C6, C11 CAP CER 2.2 µF 50V 10% X7R SMD 1206 TDK Corporation CGA5L3X7R1H225K160AB

1 C7 CAP CER 4.7 µF 50V 10% X7R SMD 1206 TDK Corporation C3216X7R1H475K160AC

1 C8 CAP CER 3.3 µF 50V 10% X7R SMD 1206 TDK Corporation C3216X7R1H335K160AC

2 C12 CAP CER 1 µF 25V 10% X7R SMD 0603 TDK Corporation CGA3E1X7R1E105K080AC

2 C13, C14 DO NOT POPULATE

2 C15, C16 CAP CER 4.7 µF 16V 10% X5R SMD 0603 TDK Corporation C1608X5R1C475K080AC

1 C17 CAP CER 220 pF 50V 5% NP0 SMD 0603 KEMET C0603C221J5GACTU

1 C18 CAP CER 1000 pF 50V 20% X7R SMD 0603 Panasonic® - ECG ECJ-1VB1H102K

1 C19 CAP CER 10000 pF 25V 10% X7R SMD 0603 Panasonic - ECG ECJ-1VB1E103K

1 C20 CAP CER 1 µF 25V 20% X5R SMD 0603 Panasonic - ECG ECJ-1V41E105M

1 C21 CAP CER 0.1 µF 50V 20% Y5V SMD 0603 AVX Corporation 06035G104ZAT2A

1 D1 DIO RECTARR BAV23,215 1V 225 mA 200V 
SMD SOT-143B

NXP 
Semiconductors

BAV23,215

1 LD1 DIO LED RED 1.8V 40 mA 10 mcd Clear 
SMD 0603

Lite-On®, Inc. LTST-C190KRKT

3 Q1, Q3, Q4 TRANS FET N-CH SIS890DN-T1-GE3 100V 
8.8A 52W PowerPAK 1212-8

Vishay Siliconix SIS890DN-T1-GE3

1 Q2 TRANS FET N-CH BSZ900N20NS3 G 200V 
15.2A 62.5W 8-PowerTDFN

Infineon
Technologies AG

BSZ900N20NS3 G

2 R1, R2 RES TKF 3.92 k1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF3921V

6 R3, R5, 
R15, R16, 
R17, R21, 
R23, R24, 
R25, R26, 
R27

RES TKF 0 1/10W SMD 0603 Panasonic - ECG ERJ-3GSY0R00V

1 R4 RES TF 0.05 1% 1W SMD 0612 Susumu Co., LTD. PRL1632-R050-F-T1

1 R6 RES TKF 0.2 1% 1W SMD 0612 ROHM 
Semiconductor

LTR18EZPFLR200

1 R7 RES TF 100k 1% 1/8W SMD 0603 Vishay 
Intertechnology, 
Inc.

MCT06030C1003FP500

1 R8 DO NOT POPULATE

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The 
released BOM used in manufacturing uses all RoHS-compliant components.
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1 R9 RES TKF 4.02k 1% 1/10W SMD 0603 Stackpole 
Electronics, Inc.

RMCF0603FT4K02

4 R10, R12, 
R13, R14

RES TKF 10k 5% 1/10W SMD 0603 Panasonic - ECG ERJ-3GEYJ103V

1 R11 RES TKF 1.02k 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF1021V

1 R18 RES TKF 475 1% 1/10W SMD 0603 Panasonic - ECG ERJ-3EKF4750V

1 R19 RES TKF 10 5% 1/10W SMD 0603 Panasonic - ECG ERJ-3GEYJ100V

1 R22 RES TKF 10 5% 1/10W SMD 0603
DO NOT POPULATE

Panasonic - ECG ERJ-3GEYJ100V

1 TR1 TRANS SMPS Flyback 1:1,2:1 SMD Würth Elektronik 750341878

1 U1 MCHP ANALOG PWM CONTROLLER 
2 MHz MCP19117-E/MQ QFN-28

Microchip
Technology Inc.

MCP19117-E/MQ

1 U2 MCHP ANALOG CHARGE PUMP 5V - 11V 
TC1240A SOT-23-6

Microchip
Technology Inc.

TC1240AECHTR

TABLE 2-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The 
released BOM used in manufacturing uses all RoHS-compliant components.

TABLE B-1: BILL OF MATERIALS (BOM) - MECHANICAL PARTS 

Qty Reference Description Manufacturer Part Number

1 PCB Printed Circuit Board - MCP19117 
Flyback Stand-Alone Evaluation Board

— 04-10403-R1

18 DESAT_N, DESAT_P, GPA2, 
GPA6, ICOMP, IFB, IP, ISN, 
ISP, PDRV, RX/DT, SDRV, 
SW1, SW2, TEST, TP1, 
VREF2, VS

MISC, TEST POINT MULTI PURPOSE 
MINI BLACK;
DO NOT POPULATE

Keystone 
Electronics 
Corp.

5001

2 J3,J5 CON HDR-2.54 Male 1x6 Gold 5.84 MH 
SMD VERT

Samtec, Inc. TSM-106-01-L-SV

4 PAD1, PAD2, PAD3, PAD4 MECH HW RUBBER PAD CYLINDRI-
CAL D7.9 H5.3 BLACK

3M SJ61A11

6 SW_1, SW_2, TP_PGND1, 
TP_PGND2, TP_VIN, 
TP_VOUT

CON TP LOOP SILVER 3.4x5 SMD Component 
Corporation

TP-107-2

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The 
released BOM used in manufacturing uses all RoHS-compliant components.
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NOTES:
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Chandler, AZ 85224-6199
Tel: 480-792-7200 
Fax: 480-792-7277
Technical Support: 
http://www.microchip.com/
support
Web Address: 
www.microchip.com
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Tel: 678-957-9614 
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Austin, TX
Tel: 512-257-3370 

Boston
Westborough, MA 
Tel: 774-760-0087 
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Chicago
Itasca, IL 
Tel: 630-285-0071 
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Cleveland
Independence, OH 
Tel: 216-447-0464 
Fax: 216-447-0643

Dallas
Addison, TX 
Tel: 972-818-7423 
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Detroit
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Houston, TX 
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Indianapolis
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Los Angeles
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New York, NY 
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San Jose, CA 
Tel: 408-735-9110

Canada - Toronto
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ASIA/PACIFIC
Asia Pacific Office
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Harbour City, Kowloon

Hong Kong
Tel: 852-2943-5100
Fax: 852-2401-3431

Australia - Sydney
Tel: 61-2-9868-6733
Fax: 61-2-9868-6755

China - Beijing
Tel: 86-10-8569-7000 
Fax: 86-10-8528-2104

China - Chengdu
Tel: 86-28-8665-5511
Fax: 86-28-8665-7889

China - Chongqing
Tel: 86-23-8980-9588
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China - Dongguan
Tel: 86-769-8702-9880 

China - Hangzhou
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China - Hong Kong SAR
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China - Nanjing
Tel: 86-25-8473-2460
Fax: 86-25-8473-2470

China - Qingdao
Tel: 86-532-8502-7355
Fax: 86-532-8502-7205

China - Shanghai
Tel: 86-21-5407-5533 
Fax: 86-21-5407-5066

China - Shenyang
Tel: 86-24-2334-2829
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China - Shenzhen
Tel: 86-755-8864-2200 
Fax: 86-755-8203-1760

China - Wuhan
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Fax: 86-27-5980-5118

China - Xian
Tel: 86-29-8833-7252
Fax: 86-29-8833-7256

ASIA/PACIFIC
China - Xiamen
Tel: 86-592-2388138 
Fax: 86-592-2388130

China - Zhuhai
Tel: 86-756-3210040 
Fax: 86-756-3210049

India - Bangalore
Tel: 91-80-3090-4444 
Fax: 91-80-3090-4123

India - New Delhi
Tel: 91-11-4160-8631
Fax: 91-11-4160-8632

India - Pune
Tel: 91-20-3019-1500

Japan - Osaka
Tel: 81-6-6152-7160 
Fax: 81-6-6152-9310

Japan - Tokyo
Tel: 81-3-6880- 3770 
Fax: 81-3-6880-3771

Korea - Daegu
Tel: 82-53-744-4301
Fax: 82-53-744-4302

Korea - Seoul
Tel: 82-2-554-7200
Fax: 82-2-558-5932 or 
82-2-558-5934

Malaysia - Kuala Lumpur
Tel: 60-3-6201-9857
Fax: 60-3-6201-9859

Malaysia - Penang
Tel: 60-4-227-8870
Fax: 60-4-227-4068

Philippines - Manila
Tel: 63-2-634-9065
Fax: 63-2-634-9069

Singapore
Tel: 65-6334-8870
Fax: 65-6334-8850

Taiwan - Hsin Chu
Tel: 886-3-5778-366
Fax: 886-3-5770-955

Taiwan - Kaohsiung
Tel: 886-7-213-7828

Taiwan - Taipei
Tel: 886-2-2508-8600 
Fax: 886-2-2508-0102

Thailand - Bangkok
Tel: 66-2-694-1351
Fax: 66-2-694-1350

EUROPE
Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393

Denmark - Copenhagen
Tel: 45-4450-2828 
Fax: 45-4485-2829

France - Paris
Tel: 33-1-69-53-63-20 
Fax: 33-1-69-30-90-79

Germany - Dusseldorf
Tel: 49-2129-3766400

Germany - Karlsruhe
Tel: 49-721-625370

Germany - Munich
Tel: 49-89-627-144-0 
Fax: 49-89-627-144-44

Italy - Milan 
Tel: 39-0331-742611 
Fax: 39-0331-466781

Italy - Venice
Tel: 39-049-7625286 

Netherlands - Drunen
Tel: 31-416-690399 
Fax: 31-416-690340

Poland - Warsaw
Tel: 48-22-3325737 

Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91

Sweden - Stockholm
Tel: 46-8-5090-4654

UK - Wokingham
Tel: 44-118-921-5800
Fax: 44-118-921-5820

Worldwide Sales and Service
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Мы молодая и активно развивающаяся компания в области  поставок 

электронных компонентов. Мы поставляем  электронные  компоненты  

отечественного и импортного производства напрямую от производителей и с 

крупнейших складов мира. 

Благодаря сотрудничеству с мировыми поставщиками мы осуществляем 

комплексные и плановые поставки   широчайшего   спектра электронных 

компонентов. 

Собственная  эффективная  логистика и склад в обеспечивает надежную 

поставку продукции в точно указанные сроки по всей России. 

Мы осуществляем  техническую поддержку нашим клиентам и 

предпродажную проверку качества продукции. На  все поставляемые продукты 

мы предоставляем  гарантию . 

Осуществляем поставки продукции под контролем ВП МО РФ на 

предприятия военно-промышленного комплекса  России , а также работаем в 

рамках 275 ФЗ с открытием отдельных счетов в уполномоченном банке. Система 

менеджмента качества компании соответствует требованиям ГОСТ ISO 9001.  

Минимальные сроки поставки, гибкие цены, неограниченный 

ассортимент  и индивидуальный подход к клиентам являются основой для 

выстраивания долгосрочного и эффективного сотрудничества с предприятиями 

радиоэлектронной промышленности, предприятиями  ВПК и научно-

исследовательскими  институтами России. 

С нами вы становитесь  еще успешнее! 

 

 

 

 

 

Наши контакты: 

Телефон: +7 812 627 14 35 

Электронная почта: sales@st-electron.ru 

Адрес: 198099, Санкт-Петербург,  

Промышленная ул, дом № 19, литера Н,  

помещение 100-Н Офис 331 

mailto:sales@st-electron.ru

